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The taxonomy in
practice

Definitions




Key principles : reminders

— /Two independent layers of functional information
— What is the relation/function expressed by the (semantics of the) DM ? = 15

—  Which type of content/elements/layer does the DM target ? =» 4

— Each function can combine with each domain (theoretically)

— Only 1 value per level (no double tags)

— You can start annotating at any level



5 Domains

Ideational Rhetorical Sequential Interpersonal

Objective relations
between external facts

Low degree of speaker
involvement

Incompatible with
expressions of opinion

Subjective relations
between thoughts or
speech-acts

Speaker’s attitude,
beliefs, reasoning
Distance from facts (“I
think that...”, “l can say
that...”)

Segments management

Structuring topics,
turns, digressions,
hesitations, stalling

Make the steps and
flow of speech more
explicit

Addressee management

Phatic function,
manifests the
relationship with the
hearer

Explicit call or answer to
the addressee



Functions I : discourse relations

— 'Addition (ADD) : S2 provides discourse-new information related to S1

— Specification (SPE) : S2 elaborates on S1 with more details or an example
— Temporal (TMP) : the two segments are chronologically ordered

—~  Cause (CAU) : S2 explains the situation in S1

— Consequence (CSQ) : S2 is the result of the situation in S1

— Condition (CND) : S2 is the condition for the truth/relevance of S1

— Concession (CCS) : S2 denies expectations related to S1

— Contrast (CTR) : the two segments differ w.r.t a shared property

— Alternative (ALT) : the segments can replace each other



Functions II : speech-specific

—'Hedging (HDG) : the DM signals some approximation

——Monitoring (MNT) : the DM signals the speaker’s intent to control the flow
— Agreeing (AGR) : the DM signals agreement

— Disagreeing (DIS) : the DM signals disagreement

— Topic (TOP) : the DM signals a start, change or return to topic

— Quoting (QUO) : the DM introduces (pseudo-)reported speech



& Examples

I L L

Addition le grand frere avait un non je marchais pas ah non Pacs avait fait une intendance  <spkl> tu dis euh cheese pour le
réle de papa et en plus non j'ai pas couru (0.180) et aux baladins (0.780) et euh cliché et genre euh un peu pour
d’étre papa il avait un j'ai fait encore un détour Camille lui dit euh tu se cacher
réle de d’essayer les oublieras pas de payer <spk2> et un peu pour se cacher
choses avant nous aussi ouai

Alternative on est plusieurs ou tu c’est pas pour ¢a qu’on faitde  euh ben j'ai fait euh deux ans  <spkl1> j'avais repris euh des
me vouvoies ? la musique mais c’est enfin enfin ma premiere et ma études en gestion des ressources

c’est pas pour étre reconnu deuxieme euh d'institutrice humaines [...]
dans la rue euh primaire <spk2> directement apres?

<spk1l> ben euh enfin jai arrété
euh I'année passée euh avril et
euh [...] 'année scolaire suivante

Concession elle devait partir le si la démocratie est un mot c’était assez comique de les cet auditeur euh vigilant il va vous
lendemain mais elle ancien, ici et maintenant la entendre parler comme ¢a dire tiens euh encore Jean
n’est jamais partie démocratie signifie la euh des filles (0.690) mais d’Ormesson mais on entend Jean
prospérité pour tous euh ouais puis apres euh d’Ormesson a chaque automne

voila quoi



Tips and notes

—/Domains form a relative cline, allow for “more” or “less” interpretations
—~—Domains might not mean exactly the same thing for all functions, be flexible

= 1In case of doubt for the function, the bias is the “dictionary” meaning

— Test phase and discussion with second annotator necessary

— Practice makes perfect ©



EXMARaLDA suite

General functionalities




11  Generalities

— |/Thomas Schmidt’s team in Hamburg (CLARIN-D)
— Open-source annotation software

—~Designed specifically for spoken text
— transcription
— text-to-sound alignment

— annotation

— Download and documentation available at:


http://exmaralda.org/en/

EXMARalLDA suite (Schmidt & Wérner

2012)

—/Corpus Manager for corpus metadata
—Partitur Editor for transcription and annotation

— Exakt for extraction/concordancer
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Pros and cons

— /Open-source — Cannot handle heavy files
~—All-in-one — Several steps for extraction
— User-friendly, intuitive (vs. Praat) — Each annotation tier per speaker

—  Few constraints (vs. ELAN)

— Interoperable format

g s



14

Input formats

~/|/ELAN (.eaf)

~— Praat (.TextGrid)

= Transcriber (.trs)

= Folker (.flk)

— CHAT (.cha)

— Anvil (.anvil)

— Annotation Graph file (.xml)
— Plain text (.txt)

— Treetagger (.txt)

— TEI (.xml)

same formats available

for export
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Annotation panel

~/\\View > Annotation panel

— —0pen : choose your .xml file in its folder

— You can edit the annotation panel with any text editor, e.g. Notepad++
— The file provided follows Crible & Degand (in press)

— You can change ir or create a new one =» cf. EXMARaLDA documentation
— The name of the « category » must be exactly the same as the name of the tier
— Automatically displays the list of available values + any description you want

— Double-click on the value to add it in the cell (avoids spelling mistakes)
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Tips for DM annotation

—'word-level segmentation
—either merge transcription tiers or double annotation tiers

— “enter list of labels as « Annotation panel » for easy use

— prefer chronological order than DM-by-DM to understand the context
— don’tdo 5 hours in a row

— keep calm ©



Creating an annotated
TedTalk

Hands-on demo




o

Exercise 1

Use transcript provided or download any from
Import it to Partitur Editor

Select segmentation rule

Create annotation tiers

Open annotation panel

Identify 5 DRDs and annotate their functions

N 0 s W

. Save as .exb file


https://www.ted.com/

Extraction and analysis

From EXMARaLDA to Excel




20  CorpusManager file (1)

~'!/Group all your annotated files (.exb) in the same folder

— 0Open « CorpusManager » (CoMa)

——File > Create corpus from transcriptions

— Name the corpus

— Click on « Browse » : go into the folder where all the .exb files are stored

— DO NOT CLICK ON ONE OF THE FILES

— click anywhere else in the folder, otherwise the corpus will erase the .exb file

— make sure that you can read: File name > *YourCorpusName*.coma
— It will show how many transcription files you have in this folder

— « Next »



21  CorpusManager file (2)

— ||« Select transcriptions » : just click on « Next »
— «Segmentation »
= Tick the box on « Segment transcriptions »

— Select « ...use default segmentation », click on « Next »

— « Metadata assignment »
} Click on « Next »
— « Speakers »

— Click on « Finish » =» you created a .coma file



22  EXAKT

— Open EXAKT

—File > Open corpus (or shortcut) and find the .coma file you just created g

— Select « RegEX(A) » [rear 7

—  Annotation: Select your tier name, e.g. « DM »  sotation: [om .

— Inthe « RegEx » box, type your search string, e.g. « well »

— Typing the dollar sign $ will give you all the annotations, everything you typed in the
« DM » tier

— Then click on the binoculars on the right M




23  Visualizing the annotations

You will see a concordancer with all your DMs.

To add the annotations from other tiers:

— Columns (top-left corner) > Add annotation

— Select the Annotation Category you want (e.g. start with « DM », then « DOMAIN »...)
— The « Exact » option is fine

— « OK »

To add metadata, such as the name of the transcription file:

Transcription

— Columns > Metadata # BB SOLRCE &)

— Selection « Filename* », click on the « + » sign, then « OK »



24 Visualizing the annotations

The result should look like this:

RegEx (A) | Annotation: | DM ¥ Regex: | §

£ 5 Communication Speaker Left Context Match Right Context oM DOMAIN_1  FUNCTIOM_1
1 all 1o hi (0.620) could vou introduce yourself please and tell us a little bit about what you do here (0.860 and SEQ ADD
2 all you do hare (0.960) yes my name is Sam (0.360) um and I run an amphibious tour operation in Plymouth (1. |and SEQ ADD
3 all uth (1.170) it 's called 'ducks 'n 'drake (0.360) right (1.100) and (0.613) and uh yeah we run around Plym _ |right INT MONI
4 all 's called 'ducks 'n "drake (0.560) right (1.100) and (0.613) and uh yeah we run around Plymouth (0.910) |and SEQ PUNCT
5 all ducks 'n "drake (0.560) right (1.100) and (0.613) and uh yeah we run around Plymouth (0.910) pickingup  |and RHE SPE
6 all n 'drake (0.360) right (1.100) and (0.613) and uh veah we run around Plymouth (0.910) pickingup inthec  |vesh INT AGR
7 all natre of town and taking people out onto the water 20 they get 3 (0.320) a an all encompassing view of =0 IDE CONS
3 all ater and on land with specialist vehicles (0.650) right (0.250) ok (0.660) and (0.130) you said this goes right INT MONI
o all nd with specialist vehicles (0.630) right (0.250) ok (0.660) and (0.130) vou said this goes round in P1 ok INT MONI
10 all cialist vehicles (0.630) right (0.230) ok (0.660) and (0.130) wou said this goes round in Plymouth could  |and SEQ TS
11 all it being Europe 's largast naval basa (0.380) uh in fact that 's why we called our (0.160) t (0.060) tour in fact RHE COMDML
I all 1 (0.160) t (0.060) tour 'ducks 'n "drake (0.860) and what 's the sipnificance of that Sir Francis drake and SEQ OPEN
13 all of that Sir Francis drake was based hers (0.750) right ok he led his he he was (0.110) playing bowls up o right INT MONI
14 all at Sir Francis drake was bazed here (0.730) right ok he led his he he was (0.110) playing bowls up on t ok INT MONI
15 all he was (0.110) playing bowls up on the ho (0.620) when he when he uh when he saw the vhinvasion andled  |when IDE TEMP
16 all 0.110) playing bowls up on the ho (0.620) when he whan he uh when he saw the uh invasion and led his (0.1 when IDE TEMP
17 all ing bowls up en the ho (0.620) when he when he uh when he saw the uh invasion and led his (0.170) led his 'when IDE TEMP
18 all () when he when he uh when he zaw the vh invazion and lzd his (0.170) led his ships out to fight them (0 and SEQ ADD
19 all 5 (0.170) led his ships out to fight them (0.720) ok (0.560) and (0.220) what 's the importance of the ok INT MONI
20 all ed his ships out to fight them (0.720) ok (0.360) and (0.220) what 's the importance of the 'ducks 'then and SEQ TS
21 all and (0.220) what 's the importance of the "ducks "then (0.150) in the name (0.480) the "ducks "are the sp then SEQ TS
22 all become (0.230) have become known as 'ducks . um | because  |(x DUKW "obvicusly sounds like 'duck "and they ' because IDE CAU
23 all um because (x DUKW 'obviously sounds like 'duck ‘and they 're amphibious ok (0.420) h (0.020) henee the and RHE SPE
24 all iously sounds like 'duck "and they 're amphibious ok (0. 420) h (0.020) hence the "ducks "in 'ducks 'n" ok INT MONI
25 all 20) hence the "ducks 'in 'ducks 'n "drake (0.930) and (0.440) why do vou think (0.050) um this kind of t  |and SEQ OFEN
26 all (0.360) um particularly unique or special (1.460) well (0.020) wou 're not going to be able toget onac weell SEQ OPEN
27 all Iz to get on a coach and then end up in the water | bzeausz  [if you do you 'll sink (0.890) the vwh (0.770) the because IDE CAU
28 all t on a coach and then end up in the water becanse if vou do yvou Il sink (0.890) the uh (0.770) the (0. if IDE COND
29 all ) alse you 'rz on (0.320) a bright yellow machine 50 people are gonna 22 you (0.520) um and and vhand  |so IDE COoNS
30 all ow machine so people ars gonna see you (0.320) um and and uh and it s a lot of fun (0.210) rather than and SEQ ADD




25  Exploring the annotations

= You can add more characters to the Left and Right context by clicking on the
magnifying glass on the right l @, ]

— By doublie-clicking on one item, you can visualize it in the transcription format at

the bottom
. [01:20.10
— You can also play it! = T 1
BB_1 WORDS] and  what s the  significance of that right ok
all WORDS] what 5 the significance of that  Sir Francis drake was  based here (07500 right ok 1
all [DM] and right ok

— You can add a « comment » column if you want, once you revise your annotations

— Columns > Add analysis > Analysis name: « Comment » > OK



26  Extracting the annotations

— | Click anywhere on the concordancer
— Ctrl + A (select everything)
— Ctrl + C (copy)

—  Go on Excel and Ctrl + V (paste on a new Excel sheet)



27  Working under Excel

—/You can now filter your data, create pivot tables and graphs, look at
frequencies...
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Inter- and intra-annotator
reliability

—Toassess the reliability and replicability of your analysis
— “Intra = repeat your annotations after a while and compare

= Inter = compare with another annotator

— % measured in Excel : [F((A1=A2);"same”;"diff")
— Kappa scores measured in R or online :

— Aim for k=0.7, see Spooren & Degand (2010)


https://nlp-ml.io/jg/software/ira/

s

-~ Thank you for your attention !

Questions and comments welcome

Ludivine Crible

ludivine.crible@ed.ac.uk



